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Introduction

This is a model of the Brüel and Kjær 4134 condenser microphone (BK 4134). The BK 
4134 is a half inch (1/2”) measurement microphone for medium and high level 
measurements in the audio range and for coupler measurements, see Figure 1. This 
microphone is of the so-called pressure response type (see Ref. 1 and Ref. 2 for further 
details). The main output parameter of the model is the microphone sensitivity that relates 
the electric output of the microphone to the acoustic pressure input. The modeled 
sensitivity is compared to measurement data from an actual BK 4134 microphone.

Figure 1: Picture of the Brüel and Kjær 4134 microphone including the protection grid 
mounted on the housing. Courtesy of Brüel and Kjær.

The BK 4134 microphone has been the subject of many modeling studies including both 
numerical, semi-analytical, and analytical models, see for example, Ref. 3, Ref. 4, and 
Ref. 5. In the analytical or semi-analytical approaches, not all effects are included as, for 
example, the non-trivial edge effects of the electric field and thus electric forces acting on 
the membrane. In this COMSOL finite element model several physics interfaces and 
features are used in a multiphysics approach to capture and couple more physical 
phenomena. These include:

1 Thermoviscous acoustics which is a detailed acoustic physics interface that explicitly 
includes and solves for thermal and viscous loss effects.

2 Electrostatics captures the changes in the electric field and electrostatic forces.
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3 Membrane for setting up a pretensioned physics for the diaphragm.

4 Moving Mesh feature for modeling the static deformation of the membrane and 
computational domain when prepolarizing the microphone.

Note: For information about the different interfaces look in the COMSOL 
documentation. Select Help>Documentation from the main menu and either enter a search 
term or look under a specific module in the documentation tree.

Note: Many of the working principles of this microphone model are described in the 
Axisymmetric Condenser Microphone model. Application Library path 
Acoustics_Module/Electroacoustic_Transducers/condenser_microphone.

M I C R O P H O N E  WO R K I N G  P R I N C I P L E S

A schematic depiction of the microphone is given in Figure 2 including the diaphragm, 
backplate (or back-electrode), insulator, vent (or pressure equalization hole), housing, and 
protection grid. The exterior housing and diaphragm are electrically insulated from the 
backplate with an insulator that seals the volume inside the microphone. A small vent used 
for pressure equalization at low frequencies is located in the housing. The distance h 
between the diaphragm and the backplate is around 19 μm. The radius of the membrane 
Rmic is 4.5 mm and the height Hmic is 3.35 mm.



4 |  T H E  B R Ü E L  &  K J Æ R  4 1 3 4  C O N D E N S E R  M I C R O P H O N E

Figure 2: Schematic representation of the Brüel and Kjær 4134 microphone. Comprising the 
diaphragm (or membrane) and the backplate (or back electrode), the housing, the insulator, 
and the protection grid. The blue colored region represents the modeled part of the transducer. 
The microphone radius is Rmic, the height of the microphone volume is Hmic, and the distance 
between the diaphragm and backplate is h. The incident pressure on the microphone is Pin and 
the pressure experienced by the vent (pressure equalization hole) is Pvent. The output voltage if 
the microphone is Vout.

The microphone works as an electro-mechanic transducer. It transforms the mechanical 
movement of the diaphragm, induced by an external incident acoustic pressure field Pin, 
into an electric signal Vout. The relation between the input pressure and the output voltage 
is the sensitivity level L, defined as

 (1)

where L0 is the normalization sensitivity, here the level at 250 Hz. A charge Q0 is applied 
to the backplate through a very large resistor in series with a DC polarization voltage 
Vpol = 200 V (not in the figure). This produces an electrostatic attraction and constant 
small DC deformation of the diaphragm. Once the diaphragm is set in motion by the 
incident acoustic field the gap distance h varies. This creates an AC voltage between the 
diaphragm/housing and the backplate. 

The shape of the electrode, the location of the holes, and the gap thickness all control the 
viscothermal damping of the diaphragm motion and thus shapes the microphone response. 
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The low frequency response is influenced by the acoustic impedance of the vent. The vent 
may either be exposed to the incident pressure field such that Pvent = Pin exp(iφ), where 
φ is a phase change due to distance, or unexposed (shielded) such that Pvent = 0 Pa. The 
first configuration is the typical when the microphone is used for field measurements. The 
second configuration occurs, for example, when the microphone is used for acoustic 
coupler measurements, where only the membrane is exposed to the sound field. More 
details are in Ref. 1 and Ref. 2.

M O D E L  A S S U M P T I O N S

• In this model it is assumed that the charge Q0 is constant. This is not fully correct. 
Electric interaction between the microphone and the external circuit induces small 
changes in the surface charge. A constant charge corresponds to charging the 
microphone through an infinitely large resistor. This means that only the acoustic cut-
off is modeled at the low frequencies and not the usual combined electric and acoustic 
cut-off.

• The incident pressure field Pin is constant across the membrane. This is true for normal 
incidence. For oblique incidence, the diaphragm diameter 2Rmic becomes comparable 
to half a wavelength λ/2 for f = 20 kHz.

• The microphone casing and protective grid are not modeled. Only the blue colored 
region in Figure 2 is modeled.

• Using simple symmetries only the lowest order rotational periodic mode of the 
diaphragm is computed and modeled.
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Figure 3: Geometry of the BK 4134 microphone. The computational mesh is reduced to 1/12 
of the geometry using symmetries.

Model Definition

G E O M E T R Y

The geometry of the Brüel and Kjær 4134 microphone is shown in Figure 3. The 
computational mesh is also shown as a 1/12 slice of the geometry. Using the symmetries 
of the model, the computational domain is reduced. Because of this symmetric 
construction the vent has been split into 6 slices (each divided into two with the symmetry) 
with the requirement that the total acoustic impedance of the six slices equals the original 
single hole.
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P A R A M E T E R S

The parameters defined in the model are given in the table below. The properties of air are 
standard values from the COMSOL air material. The diaphragm is made of nickel and its 
material parameters are given in the table.

B O U N D A R Y  C O N D I T I O N S

In the exposed vent configuration the pressure at the vent is given by

 (2)

where Hmic is the height of the microphone (see Figure 2), k is the wave number, ω is the 
angular frequency, and c = 343 m/s is the speed of sound at 20oC and 1 atm. It is here 
assumed that the incident sound is a plane wave normal to the diaphragm.

Details about the other boundary conditions used in this model are found in the 
Axisymmetric Condenser Microphone model and in the Modeling Instructions below.

Results and Discussion

The sensitivity of the microphone given by Equation 1 is shown in Figure 4. The modeled 
curves of the exposed and unexposed vent configurations are plotted in blue and pink, 
respectively. Three measurement curves of actual responses of a BK 4134 microphone are 
depicted in green, red, and cyan. The measured curves illustrate the variability in the 

TABLE 1:  MODEL PARAMETERS

VARIABLE VALUE DESCRIPTION

Tm0 3160 N/m Membrane tension

Em 2.21·1011 Ps Young’s modulus of membrane

νm 0.4 Poisson’s ratio for membrane

tm 5 μm Membrane thickness

ρm 890 kg/m3 Membrane density

ρms 0.0445 kg/m2 Membrane surface density (= tm·ρm)

Q0 3.145·10-10 C Electrode charge yielding Vpol = 200 V

Pin 1 Pa Incident pressure amplitude

Pvent 1 Pa / 0 Pa Vent pressure (exposed/unexposed)

fmax 20 kHz Maximal study frequency

dvisc 22 μm(100 Hz/fmax)0.5 Viscous boundary layer thickness at fmax

L0 39.5 dB Normalization sensitivity

Pvent Pineiφ
= φ k– Hmic

ω
c
----– Hmic= =
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sensitivity of a microphone - this is why each measurement microphone is delivered with 
an individual calibration curve. The measured curves are only valid from 200 Hz and 
upwards. The microphone sensitivity is also illustrated in 1/3 octaves at the very end of 
this model description.

The frequency response of the microphone for frequencies below 100 Hz show different 
behavior depending on the vent configuration (compare this to Fig. 2.7 in Ref. 2). In the 
exposed configuration the vent equalizes the pressure on both sides of the membrane (the 
phase lag  is small) and thus reduces the pressure drop across the diaphragm, in turn 
reducing the sensitivity. In the unexposed configuration the sensitivity is seen to increase 
at the lowest frequencies. Here the stiffness of the internal air cavity becomes smaller.

Figure 4: Microphone sensitivity curve from the model with vent exposed (blue) and vent 
unexposed (pink). Three measurement curves are also added (green, red, and cyan) to 
illustrate the variability in the microphone sensitivity.

The deformation of the membrane is shown in Figure 5 for 20 kHz and 1 kHz, top and 
bottom, respectively. At 20 kHz, where the sensitivity starts to fall off, the influence of the 
holes on the membrane deformation is visible (see for example, Ref. 4 for measured 
membrane modes).

φ
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Figure 5: Diaphragm deformation at f = 20 kHz (top) and f = 1 kHz (bottom).
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The static electric potential distribution that results from prepolarizing the microphone is 
shown in Figure 6; notice that the maximal voltage is just over 200 V.

Figure 6: Static electric potential resulting from the prepolarization of the microphone 
cartridge and diaphragm.
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Application Library path: Acoustics_Module/Electroacoustic_Transducers/
bk_4134_microphone

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, click 3D.

2 In the Select Physics tree, select Acoustics>Thermoviscous Acoustics>

Thermoviscous Acoustics, Frequency Domain (ta).

3 Click Add.

4 In the Select Physics tree, select Structural Mechanics>Membrane (mbrn).

5 Click Add.

6 In the Displacement field text field, type um.

7 In the Displacement field components table, enter the following settings:

The displacement field of the membrane is (um,vm,wm) while the velocity field in the 
fluid is (u,v,w).

8 In the Select Physics tree, select AC/DC>Electrostatics (es).

9 Click Add.

10 Click Done.

um

vm

wm
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G E O M E T R Y  1

Skip setting up the study types for now because a couple of manual steps are needed to set 
up the linear perturbation solver properly.

Import the parameters that define the diaphragm material, static surface charge, and 
incident and vent pressures as well as some mesh related parameters. The parameters are 
presented in Table 1.

G L O B A L  D E F I N I T I O N S

Parameters
1 In the Model Builder window, under Global Definitions click Parameters.

2 In the Settings window for Parameters, locate the Parameters section.

3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file 
bk_4134_microphone_parameters.txt.

Import the geometry which represents one 12th of the Brüel and Kjær 4134 
microphone, see Figure 3. The geometry is courtesy of Brüel and Kjær.

G E O M E T R Y  1

Import 1 (imp1)
1 On the Home toolbar, click Import.

2 In the Settings window for Import, locate the Import section.

3 Click Browse.

4 Browse to the model’s Application Libraries folder and double-click the file 
bk_4134_microphone.mphbin.
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5 Click Import.

The geometry should look like the one in the figure below.

Next, add three interpolation functions that represent measurement data of the 
sensitivity of an actual microphone.

D E F I N I T I O N S

Interpolation 1 (int1)
1 On the Home toolbar, click Functions and choose Local>Interpolation.

2 In the Settings window for Interpolation, locate the Definition section.

3 From the Data source list, choose File.

4 Click Browse.

5 Browse to the model’s Application Libraries folder and double-click the file 
bk_4134_microphone_sensitivity_data.txt.

6 In the Number of arguments text field, type 1.

7 Click Import.
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8 Find the Functions subsection. In the table, enter the following settings:

Add predefined selections of boundaries to use when setting up the rest of the physics 
in the model. Rename the selections such that they are easy to use.

Explicit 1
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, locate the Input Entities section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundaries 4, 16, and 26 only.

5 In the Label text field, type Membrane.

Explicit 2
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Symmetry in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Click the Wireframe Rendering button on the Graphics toolbar.

Use the wireframe rendering for easier visualization of the selections.

5 Select Boundaries 1, 2, 5, 11, 14, 21, 24, 29, and 34 only.

Function name Position in file

int_ave 1

int_min 2

int_max 3
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6 Click the Zoom Extents button on the Graphics toolbar.

Explicit 3
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Pressure Release in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundary 32 only.

Explicit 4
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Ground in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.

4 Select Boundaries 3, 6–10, 12, 17, 19, and 22 only.

Explicit 5
1 On the Definitions toolbar, click Explicit.

2 In the Settings window for Explicit, type Terminal in the Label text field.

3 Locate the Input Entities section. From the Geometric entity level list, choose Boundary.
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4 Select Boundaries 4, 16, 26–28, and 36 only.

Select air as the material to be used in the model and set up a material with the 
membrane properties.

A D D  M A T E R I A L

1 On the Home toolbar, click Add Material to open the Add Material window.

2 Go to the Add Material window.

3 In the tree, select Built-In>Air.

4 Click Add to Component in the window toolbar.

M A T E R I A L S

Air (mat1)
1 In the Settings window for Material, locate the Material Contents section.

2 In the table, enter the following settings:

Material 2 (mat2)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, type Membrane Material in the Label text field.

3 Locate the Geometric Entity Selection section. From the Geometric entity level list, 
choose Boundary.

4 From the Selection list, choose Membrane.

5 Locate the Material Contents section. In the table, enter the following settings:

6 On the Home toolbar, click Add Material to close the Add Material window.

To set up the acoustic model, set the acoustic velocity equal to the deformation of the 
diaphragm, provide two pressure boundary conditions at the vent (exposed and 

Property Variable Value Unit Property group

Bulk viscosity muB 0 Pa·s Basic

Property Variable Value Unit Property group

Young’s modulus E Em Pa Basic

Poisson’s ratio nu num 1 Basic

Density rho rhom kg/m³ Basic
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unexposed), and apply symmetry conditions. When solving the model, only one of the 
pressure boundary conditions at the time will be active.

T H E R M OV I S C O U S  A C O U S T I C S ,  F R E Q U E N C Y  D O M A I N  ( T A )

Symmetry 1
1 On the Physics toolbar, click Boundaries and choose Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 From the Selection list, choose Symmetry.

Pressure (Adiabatic) 1
1 On the Physics toolbar, click Boundaries and choose Pressure (Adiabatic).

2 In the Settings window for Pressure (Adiabatic), locate the Boundary Selection section.

3 From the Selection list, choose Pressure Release.

4 Locate the Pressure section. In the pbnd text field, type linper(pvent_e*exp(-
ta.iomega*Hmic/343[m/s])).

See the expression for the vent pressure given in Equation 2.

Pressure (Adiabatic) 2
1 On the Physics toolbar, click Boundaries and choose Pressure (Adiabatic).

2 In the Settings window for Pressure (Adiabatic), locate the Boundary Selection section.

3 From the Selection list, choose Pressure Release.

4 Locate the Pressure section. In the pbnd text field, type linper(pvent_u).

The linper() operator is used to indicate load terms that should only be included 
when solving the linear perturbation part of the model, that, is the frequency-
dependent terms. For more information look under Help > Documentation and search 
for Special Operators.

Model the diaphragm using the Membrane interface. Constrain the membrane at the 
outer ridge, add an initial stress equal to the membrane tension Tm0, and set up zero 
displacement in the horizontal plane on the symmetry edges. Finally, add the forces/
loads that act on the membrane, that is, the incident pressure field Pin and the 
electrostatic forces given by the Maxwell stress tensor components (es.dnTex,
es.dnTey,es.dnTez).

M E M B R A N E  ( M B R N )

1 In the Model Builder window, under Component 1 (comp1) click Membrane (mbrn).

2 In the Settings window for Membrane, locate the Boundary Selection section.
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3 From the Selection list, choose Membrane.

4 Locate the Thickness section. In the d text field, type tm.

Linear Elastic Material 1
In the Model Builder window, under Component 1 (comp1)>Membrane (mbrn) click 
Linear Elastic Material 1.

Initial Stress and Strain 1
1 On the Physics toolbar, click Attributes and choose Initial Stress and Strain.

2 In the Settings window for Initial Stress and Strain, locate the Initial Stress and Strain 
section.

3 In the N0 table, enter the following settings:

Fixed Constraint 1
1 On the Physics toolbar, click Edges and choose Fixed Constraint.

2 Select Edge 74 only.

Symmetry 1
1 On the Physics toolbar, click Edges and choose Symmetry.

2 Select Edges 4, 5, 25, 42, 49, and 57 only.

Face Load 1
1 On the Physics toolbar, click Boundaries and choose Face Load.

2 In the Settings window for Face Load, locate the Boundary Selection section.

3 From the Selection list, choose Membrane.

4 Locate the Force section. From the Load type list, choose Pressure.

5 In the p text field, type linper(pin).

Face Load 2
1 On the Physics toolbar, click Boundaries and choose Face Load.

2 In the Settings window for Face Load, locate the Boundary Selection section.

3 From the Selection list, choose Membrane.

Tm0 0

0 Tm0
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4 Locate the Force section. Specify the FA vector as

Proceed to set up the Electrostatics interface. Add a ground boundary and a terminal 
boundary with a constant charge Q0.

E L E C T R O S T A T I C S  ( E S )

In the Model Builder window, under Component 1 (comp1) click Electrostatics (es).

Ground 1
1 On the Physics toolbar, click Boundaries and choose Ground.

2 In the Settings window for Ground, locate the Boundary Selection section.

3 From the Selection list, choose Ground.

Terminal 1
1 On the Physics toolbar, click Boundaries and choose Terminal.

2 In the Settings window for Terminal, locate the Boundary Selection section.

3 From the Selection list, choose Terminal.

4 Locate the Terminal section. In the Q0 text field, type Q0.

Set up the Moving Mesh feature. This feature allows for a precise calculation of the 
stationary shape of the membrane, the electric field, and forces. Set the mesh to move/
deform with the membrane and set a Symmetry condition on the symmetry boundaries.

Deforming Domain 1
On the Definitions toolbar, click Moving Mesh and choose Deforming Domain.

D E F I N I T I O N S

Deforming Domain 1
Select Domains 1, 3, and 4 only.

Fixed Boundary 1
1 On the Definitions toolbar, click Moving Mesh and choose Fixed Boundary.

2 In the Settings window for Fixed Boundary, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 3, 15, 25, 36 in the Selection text field.

es.dnTex x

es.dnTey y

es.dnTez z
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5 Click OK.

Prescribed Mesh Displacement 1
1 On the Definitions toolbar, click Moving Mesh and choose Prescribed Mesh Displacement.

2 In the Settings window for Prescribed Mesh Displacement, locate the Boundary Selection 
section.

3 Click Paste Selection.

4 Locate the Prescribed Mesh Displacement section. Specify the dx vector as

5 In the Paste Selection dialog box, type 4, 16, 26 in the Selection text field.

6 Click OK.

Symmetry 1
1 On the Definitions toolbar, click Moving Mesh and choose Symmetry.

2 In the Settings window for Symmetry, locate the Boundary Selection section.

3 Click Paste Selection.

4 In the Paste Selection dialog box, type 1, 2, 14, 21, 24, 29 in the Selection text field.

5 Click OK.

Finally, proceed with coupling the membrane to the acoustics using the predefined 
multiphysics coupling.

M U L T I P H Y S I C S

Thermoviscous Acoustic-Structure Boundary 1 (tsb1)
1 On the Physics toolbar, click Multiphysics Couplings and choose Boundary>

Thermoviscous Acoustic-Structure Boundary.

2 In the Settings window for Thermoviscous Acoustic-Structure Boundary, locate the 
Boundary Selection section.

3 From the Selection list, choose Membrane.

You have now defined all the physics, multiphysics, and boundary conditions of the 
model. Proceed with defining the computational mesh. Because the model is large and 
the mesh has to be used for a wide frequency range, some compromise is needed. If the 
mesh was to resolve the acoustic boundary layer for all frequencies, the model would 

um X

vm Y

wm Z
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become extremely large and difficult to solve. To reduce the mesh, the boundary layer 
is only properly resolved in the thin air slit between the diaphragm and backplate where 
most damping losses occur. At frequencies below around 1000 Hz the mesh is also 
adequate in the back volume. Above this frequency the losses in the back volume are 
minimal.

M E S H  1

Free Triangular 1
1 In the Model Builder window, under Component 1 (comp1) right-click Mesh 1 and choose 

More Operations>Free Triangular.

2 In the Settings window for Free Triangular, locate the Boundary Selection section.

3 From the Selection list, choose Membrane.

Size 1
1 Right-click Component 1 (comp1)>Mesh 1>Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Element Size section.

3 Click the Custom button.

4 Locate the Element Size Parameters section. Select the Maximum element size check box.

5 In the associated text field, type 0.5[mm].

Free Triangular 1
To properly resolve the solution near the edges of the holes in the backplate and the outer 
rim, the mesh size needs to be determined by the thickness of the acoustic boundary layer. 
More specifically, specify a maximum element size at these edges equal to 4 times the 
boundary layer thickness at 20 kHz.

Size 2
1 Right-click Free Triangular 1 and choose Size.

2 In the Settings window for Size, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Edge.

4 Select Edges 24, 35, and 48 only.

5 Locate the Element Size section. Click the Custom button.

6 Locate the Element Size Parameters section. Select the Maximum element size check box.

7 In the associated text field, type 4*dvisc.

8 Click Build Selected.
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Swept 1
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domains 1, 3, and 4 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Swept 1 and choose Distribution.

2 In the Settings window for Distribution, locate the Distribution section.

3 In the Number of elements text field, type 3.

4 Click Build Selected.

Mapped 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Mapped.

2 Select Boundary 33 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Mapped 1 and choose Distribution.

2 Select Edges 61 and 68 only.

Distribution 2
1 Right-click Mapped 1 and choose Distribution.

2 Select Edges 62 and 65 only.

3 In the Settings window for Distribution, locate the Distribution section.

4 In the Number of elements text field, type 2.

5 Click Build Selected.

Swept 2
1 In the Model Builder window, right-click Mesh 1 and choose Swept.

2 In the Settings window for Swept, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 5 only.

Distribution 1
1 Right-click Component 1 (comp1)>Mesh 1>Swept 2 and choose Distribution.

2 In the Settings window for Distribution, click Build Selected.
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Boundary Layers 1
1 In the Model Builder window, right-click Mesh 1 and choose Boundary Layers.

2 In the Settings window for Boundary Layers, locate the Domain Selection section.

3 From the Geometric entity level list, choose Domain.

4 Select Domain 5 only.

Boundary Layer Properties
1 In the Model Builder window, under Component 1 (comp1)>Mesh 1>Boundary Layers 1 

click Boundary Layer Properties.

2 Select Boundary 33 only.

3 In the Settings window for Boundary Layer Properties, locate the 
Boundary Layer Properties section.

4 In the Number of boundary layers text field, type 2.

5 Click Build Selected.

Convert 1
1 In the Model Builder window, right-click Mesh 1 and choose More Operations>Convert.

2 In the Settings window for Convert, locate the Geometric Entity Selection section.

3 From the Geometric entity level list, choose Boundary.

4 Select Boundary 33 only.

5 Click Build Selected.

6 Click the Zoom to Selection button on the Graphics toolbar.

Size 1
1 Right-click Mesh 1 and choose Free Tetrahedral.

2 In the Model Builder window, under Component 1 (comp1)>Mesh 1 right-click 
Free Tetrahedral 1 and choose Size.

3 In the Settings window for Size, locate the Element Size section.

4 Click the Custom button.

5 Locate the Element Size Parameters section. Select the Maximum element size check box.

6 In the associated text field, type 0.5[mm].

7 Select the Resolution of narrow regions check box.

8 In the associated text field, type 1.

9 Click Build All.
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10 Click the Zoom Extents button on the Graphics toolbar.

The final mesh should look like that in the figure below.

Add two studies to solve the model: one for the case where the vent is exposed to the 
incident pressure Pin and another for the case where the vent is unexposed (shielded) 
from the incident pressure field.

Solve the model using the linear-perturbation solver in the frequency domain. In order 
for the solver to work, first perform a stationary study to determine the linearization 
point. This first study deforms the membrane and mesh due to the electrostatic forces 
(from the DC polarization voltage) and includes the effects of the static membrane 
tension Tm0. The second study models the acoustic perturbation to the static solution, 
that is the small-parameter harmonic variations of the acoustic pressure, temperature, 
and velocity.

Because this is a strongly coupled multiphysics problem, set the stationary solver to fully 
coupled (in contrast to the default segregated type). The frequency domain solver is 
fully coupeled, per default, when frequency domain perturbation is used. Also set the 
solvers to be direct and in the frequency domain step use PARDISO. The model should 
solve on a computer with 6 GB of RAM or more.

A D D  S T U D Y

1 On the Home toolbar, click Add Study to open the Add Study window.
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2 Go to the Add Study window.

3 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
the Thermoacoustics, Frequency Domain (ta) interface.

4 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

5 Click Add Study in the window toolbar.

S T U D Y  1

1 In the Settings window for Study, locate the Study Settings section.

2 Clear the Generate default plots check box.

Step 1: Stationary
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain Perturbation.

2 In the Settings window for Stationary, locate the Study Settings section.

3 Select the Include geometric nonlinearity check box.

Step 2: Frequency Domain Perturbation
1 In the Model Builder window, under Study 1 click Step 2: Frequency Domain Perturbation.

2 In the Settings window for Frequency Domain Perturbation, locate the Study Settings 
section.

3 Select the Include geometric nonlinearity check box.

4 In the Frequencies text field, type 10^{range(0,3/10,3)} 10^{range(3.3,1/20,
4.3)}.

This will give you 10 frequencies on a logarithmic scale from 1 Hz to 1 kHz and further 
20 frequencies from approximately 2 kHz to 20 kHz.

5 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step check box.

6 In the Physics and variables selection tree, select Component 1 (comp1)>

Thermoviscous Acoustics, Frequency Domain (ta)>Pressure (Adiabatic) 2.

7 Click Disable.

Solution 1 (sol1)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 1 (sol1) node.

3 In the Model Builder window, expand the Study 1>Solver Configurations>

Solution 1 (sol1)>Stationary Solver 1 node.
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4 Right-click Study 1>Solver Configurations>Solution 1 (sol1)>Stationary Solver 1 and 
choose Fully Coupled.

5 Right-click Study 1>Solver Configurations>Solution 1 (sol1)>Stationary Solver 1>Direct 
and choose Enable.

6 In the Model Builder window, expand the Study 1>Solver Configurations>

Solution 1 (sol1)>Stationary Solver 2 node, then click Direct 1.

7 In the Settings window for Direct, locate the General section.

8 From the Solver list, choose PARDISO.

Solve the model for the case where the vent is exposed to the incoming signal Pin. 
Solving the model for all the desired frequencies may take up to 15 min.

9 On the Study toolbar, click Compute.

Set up a second study for the unexposed vent case, where Pvent = 0 Pa. The procedure 
is the same as for setting up the first study. This time, solve the model only from 1 Hz 
to 1 kHz as the effect of the vent exposure is in the lower frequencies. Disable the first 
pressure boundary condition so that only the unvented case is treated.

A D D  S T U D Y

1 Go to the Add Study window.

2 Find the Physics interfaces in study subsection. In the table, clear the Solve check box for 
the Thermoacoustics, Frequency Domain (ta) interface.

3 Find the Studies subsection. In the Select Study tree, select Preset Studies>Stationary.

4 Click Add Study in the window toolbar.

5 On the Study toolbar, click Add Study to close the Add Study window.

S T U D Y  2

1 In the Settings window for Study, locate the Study Settings section.

2 Clear the Generate default plots check box.

Step 1: Stationary
1 On the Study toolbar, click Study Steps and choose Frequency Domain>

Frequency Domain Perturbation.

2 In the Settings window for Stationary, locate the Study Settings section.

3 Select the Include geometric nonlinearity check box.

Step 2: Frequency Domain Perturbation
1 In the Model Builder window, under Study 2 click Step 2: Frequency Domain Perturbation.
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2 In the Settings window for Frequency Domain Perturbation, locate the Study Settings 
section.

3 Select the Include geometric nonlinearity check box.

4 In the Frequencies text field, type 10^{range(0,3/10,3)}.

This gives 10 frequencies on a logarithmic scale from 1 Hz to 1 kHz.

5 Locate the Physics and Variables Selection section. Select the 
Modify model configuration for study step check box.

6 In the Physics and variables selection tree, select Component 1 (comp1)>

Thermoviscous Acoustics, Frequency Domain (ta)>Pressure (Adiabatic) 1.

7 Click Disable.

Solution 3 (sol3)
1 On the Study toolbar, click Show Default Solver.

2 In the Model Builder window, expand the Solution 3 (sol3) node.

3 In the Model Builder window, expand the Study 2>Solver Configurations>

Solution 3 (sol3)>Stationary Solver 1 node.

4 Right-click Study 2>Solver Configurations>Solution 3 (sol3)>Stationary Solver 1 and 
choose Fully Coupled.

5 Right-click Study 2>Solver Configurations>Solution 3 (sol3)>Stationary Solver 1>Direct 
and choose Enable.

6 In the Model Builder window, expand the Study 2>Solver Configurations>

Solution 3 (sol3)>Stationary Solver 2 node, then click Direct 1.

7 In the Settings window for Direct, locate the General section.

8 From the Solver list, choose PARDISO.

Solve the model for the case where the vent is unexposed to the incoming signal Pin.

9 On the Study toolbar, click Compute.

R E S U L T S

Four data sets have been created automatically:

• Study 1/Solution 1 contains the full solution of the exposed.

• Study 1/Solution Store 1 contains the stationary solution, that is, the linearization 
point, for Study 1.

• Study 2/Solution 3 contains the full solution of the unexposed vent configuration.

• Study 2/Solution Store 2 contains the stationary solution for Study 2.



28 |  T H E  B R Ü E L  &  K J Æ R  4 1 3 4  C O N D E N S E R  M I C R O P H O N E

1 In the Model Builder window, expand the Results node.

Data Sets
Create a Sector 3D dataset to visualize the full geometry.

Study 1/Solution 1 (sol1)
1 In the Model Builder window, expand the Results>Data Sets node, then click Study 1/

Solution 1 (sol1).

2 In the Settings window for Solution, locate the Solution section.

3 From the Frame list, choose Material (X, Y, Z).

Sector 3D 1
1 On the Results toolbar, click More Data Sets and choose Sector 3D.

2 In the Settings window for Sector 3D, locate the Symmetry section.

3 In the Number of sectors text field, type 12.

4 From the Transformation list, choose Rotation and reflection.

5 Find the Radial direction of reflection plane subsection. In the X text field, type 0.

6 In the Y text field, type -1.

Derived Values
Evaluate the stationary terminal voltage to see if it is equal to the polarization voltage Vpol 
= 200 V as expected.

Global Evaluation 1
1 On the Results toolbar, click Global Evaluation.

2 In the Settings window for Global Evaluation, click Replace Expression in the upper-right 
corner of the Expressions section. From the menu, choose Component 1>Electrostatics>

Terminals>es.V0_1 - Terminal voltage.

3 Locate the Expressions section. From the Expression evaluated for list, choose 
Static solution.

4 Click Evaluate.

Next, set up 3D plots to visualize the solution in the computational domain, including 
membrane deformation, particle velocity, sound pressure levels, acoustic temperature 
variations, and the static electric potential.

3D Plot Group 1
1 On the Results toolbar, click 3D Plot Group.
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2 In the Settings window for 3D Plot Group, type Membrane Deformation in the Label text 
field.

3 Locate the Data section. From the Data set list, choose Sector 3D 1.

Surface 1
1 Right-click Membrane Deformation and choose Surface.

2 In the Settings window for Surface, locate the Expression section.

3 In the Expression text field, type mbrn.disp.

Deformation 1
1 Right-click Results>Membrane Deformation>Surface 1 and choose Deformation.

2 On the Membrane Deformation toolbar, click Plot.

3 Click the Zoom Extents button on the Graphics toolbar.

Membrane Deformation
The plot should look like the one in Figure 5 top.

Change the evaluation frequency to 1000 Hz.

1 In the Model Builder window, under Results click Membrane Deformation.

2 In the Settings window for 3D Plot Group, locate the Data section.

3 From the Parameter value (freq (Hz)) list, choose 1000.

4 On the Membrane Deformation toolbar, click Plot.

The plot should look like the one in Figure 5 bottom.

3D Plot Group 2
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Velocity in the Label text field.

Slice 1
1 Right-click Velocity and choose Slice.

2 In the Settings window for Slice, locate the Expression section.

3 In the Expression text field, type ta.v_inst.

4 Locate the Plane Data section. From the Plane list, choose ZX-planes.
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5 On the Velocity toolbar, click Plot.

The plot shows the instantaneous velocity amplitude. Possibly zoom to the area near the 
backplate perforation and the membrane to see the highest amplitudes.

3D Plot Group 3
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Sound Pressure Level in the Label text 
field.

Volume 1
1 Right-click Sound Pressure Level and choose Volume.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type ta.Lp.
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4 On the Sound Pressure Level toolbar, click Plot.

The sound pressure level distribution inside the microphone is seen here.

3D Plot Group 4
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Temperature in the Label text field.

3 Locate the Data section. From the Parameter value (freq (Hz)) list, choose 1000.

Volume 1
1 Right-click Temperature and choose Volume.

2 In the Settings window for Volume, locate the Expression section.

3 In the Expression text field, type T.

4 On the Temperature toolbar, click Plot.

The acoustic temperature variation T inside the microphone is here seen at 1000 Hz. 
The thermal boundary layer is clearly visible. If you change the evaluation frequency to 
a lower value you can study the transition to the isothermal behavior. Here T is nearly 
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constant and 0 inside the microphone (note the min/max numerical values on the color 
bar).

3D Plot Group 5
1 On the Home toolbar, click Add Plot Group and choose 3D Plot Group.

2 In the Settings window for 3D Plot Group, type Electric Potential in the Label text 
field.

3 Locate the Data section. From the Data set list, choose Sector 3D 1.

Multislice 1
1 On the Electric Potential toolbar, click More Plots and choose Multislice.

2 In the Settings window for Multislice, locate the Expression section.

3 In the Expression text field, type V.

4 From the Expression evaluated for list, choose Static solution.

5 Locate the Multiplane Data section. Find the Z-planes subsection. In the Planes text field, 
type 3.
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6 On the Electric Potential toolbar, click Plot.

The plot should look like the one in Figure 6.

Now create three 1D plots to visualize the microphone sensitivity, membrane 
deformation, and Maxwell stresses.

1D Plot Group 6
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Sensitivity in the Label text field.

3 Locate the Plot Settings section. Select the x-axis label check box.

4 In the associated text field, type f (Hz).

5 Select the y-axis label check box.

6 In the associated text field, type dB (rel. 1 V/Pa).

7 Click to expand the Title section. From the Title type list, choose Manual.

8 In the Title text area, type Sensitivity.

9 Click to expand the Legend section. From the Position list, choose Lower right.

Global 1
1 Right-click Sensitivity and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 On the Sensitivity toolbar, click Plot.

5 Click the x-Axis Log Scale button on the Graphics toolbar.

Global 2
1 In the Model Builder window, under Results right-click Sensitivity and choose Global.

2 In the Settings window for Global, locate the Data section.

3 From the Data set list, choose Study 2/Solution 3 (sol3).

Expression Unit Description

20*log10(abs(es.V0_1/pin))+L0 Model (vent exposed)

int_ave(freq) Average measurement

int_min(freq) Lower measurement

int_max(freq) Upper measurement



34 |  T H E  B R Ü E L  &  K J Æ R  4 1 3 4  C O N D E N S E R  M I C R O P H O N E

4 Locate the y-Axis Data section. In the table, enter the following settings:

5 On the Sensitivity toolbar, click Plot.

The plot of the microphone sensitivity should look like the one in Figure 4.

1D Plot Group 7
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Static Membrane Deformation in the 
Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Static Membrane Deformation.

Line Graph 1
1 Right-click Static Membrane Deformation and choose Line Graph.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type wm.

4 Select Edges 4, 25, 42, and 57 only.

5 From the Expression evaluated for list, choose Static solution.

Line Graph 2
1 In the Model Builder window, under Results right-click Static Membrane Deformation and 

choose Line Graph.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type wm.

4 Select Edges 5 and 49 only.

5 From the Expression evaluated for list, choose Static solution.

Expression Unit Description

20*log10(abs(es.V0_1/pin))+L0 Model (vent unexposed)
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6 On the Static Membrane Deformation toolbar, click Plot.

The figure below shows the static deformation of the membrane due to the pre-
polarization, plotted along the two symmetry boundaries. Note the small difference in 
the curves due to the presence of the hole in the backplate.

Static Membrane Deformation 1
1 Right-click Static Membrane Deformation and choose Duplicate.

2 In the Settings window for 1D Plot Group, type Maxwell Stress in the Label text field.

3 Click to expand the Title section. From the Title type list, choose Manual.

4 In the Title text area, type Static Maxwell Stress.

Line Graph 1
1 In the Model Builder window, expand the Results>Maxwell Stress node, then click 

Line Graph 1.

2 In the Settings window for Line Graph, locate the y-Axis Data section.

3 In the Expression text field, type es.dnTz.

Line Graph 2
1 In the Model Builder window, under Results>Maxwell Stress click Line Graph 2.

2 In the Settings window for Line Graph, locate the y-Axis Data section.
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3 In the Expression text field, type es.dnTz.

4 On the Maxwell Stress toolbar, click Plot.

This figure depicts the static electric surface forces (Maxwell stresses) acting on the 
membrane due to the pre-polarization. Again notice the difference in the two curves, 
which is due to the presence of the hole in the backplate.

Finally, reproduce the sensitivity curve in 1/3 octave bands (in the exposed vent 
configuration) using the Octave Band plot.

1D Plot Group 9
1 On the Home toolbar, click Add Plot Group and choose 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Sensitivity, 1/3 Octave Bands in 
the Label text field.

Octave Band 1
1 On the Sensitivity, 1/3 Octave Bands toolbar, click More Plots and choose Octave Band.

2 In the Settings window for Octave Band, locate the Selection section.

3 From the Geometric entity level list, choose Global.

4 Locate the y-Axis Data section. From the Expression type list, choose Transfer function.

5 In the Level reference text field, type L0.
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6 In the Expression text field, type abs(es.V0_1/pin)^2.

The expression represents the power transfer function H from the incident pressure to 
measured voltage.

7 Locate the Plot section. From the Style list, choose 1/3 octave bands.

8 On the Sensitivity, 1/3 Octave Bands toolbar, click Plot.
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An analytical-numerical method for determining the mechanical
response of a condenser microphone
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The paper is based on determining the reaction pressure on the diaphragm of a condenser microphone

by integrating numerically the frequency domain Stokes system describing the velocity and the

pressure in the air domain beneath the diaphragm. Afterwards, the membrane displacement can be

obtained analytically or numerically. The method is general and can be applied to any geometry of

the backplate holes, slits, and backchamber. As examples, the method is applied to the Bruel & Kjaer

(B&K) 4134 1/2-inch microphone determining the mechanical sensitivity and the mechano-thermal

noise for a domain of frequencies and also the displacement field of the membrane for two specified

frequencies. These elements compare well with the measured values published in the literature. Also

a new design, completely micromachined (including the backvolume) of the B&K micro-electro-me-

chanical systems (MEM) 1/4-inch measurement microphone is proposed. It is shown that its mechani-

cal performances are very similar to those of the B&K MEMS measurement microphone.
VC 2011 Acoustical Society of America. [DOI: 10.1121/1.3652853]

PACS number(s): 43.38.Kb, 43.38.Bs [AJZ] Pages: 3698–3705

I. INTRODUCTION

Predicting the response of a condenser microphone due

to an incoming sound wave in terms of its geometrical and

material properties is an almost century old problem. The

difficulties in its approaches are related especially with the

coupling of the vibration of the membrane with the oscilla-

tions of the underlying air layer. While the general motion

of a membrane supported on a rigid circular frame at its

periphery, driven by a given surface force is known [see

Chapter 9 in the book by Rayleigh (Ref. 1, and the referen-

ces therein)] the fluid motion in the air domain (including

the gap, holes, slit and backvolume) is more difficult to

describe analytically.

The first general approaches of the condenser micro-

phone analysis were based on a simplified model using some

lumped elements by Wente2 in 1917 and Crandall3 in 1918

using simplifying assumptions about the pressure and parti-

cle velocity in the air domain, as have been considered by

Warren et al.4 in their paper published in 1973.

A second approach was based on using the Navier-

Stokes (N-S) system for describing the motion of the viscous

fluid (air) coupled with the vibrating membrane. Thus,

Robey5 in 1954 tried to solve the N-S system in a cylindrical

domain (the underlying air) but used the unphysical bound-

ary condition of vanishing pressure on the external circular

cylindrical surface. Petritskaya6,7 in 1966–1968, improved

Robey’s solution by considering the appropriate boundary

condition of vanishing fluid velocity on the external circular

surface. Also, she accounted for the presence of openings in

the backplate. Zuckerwar8 in 1978 made two key assump-

tions which enabled him to simplify the analysis and obtain

a closed form solution. He assumed that the membrane

displacement is axi-symmetrical and that the reaction pres-

sure is relatively insensitive to the shape of the diaphragm.

The excellent agreement between the theory and experiment

in the case of the Bruel & Kjaer (B&K) 1-in. and 1/2-in

microphones shows that Zuckerwar’s theory describes accu-

rately the microphone behavior. A complete analysis for the

B&K type 4146 1-in. microphone is also included in Ref. 9.

Tan and Miao10 in 2006 reviewed the theory of condenser

microphones and proposed a new analytical modeling

method for the B&K MEMS condenser microphone. The

theoretical results obtained by this method were found to be

in very good agreement with the experimental results

reported in the case of a B&K MEMS microphone in

Ref. 12. Very recently, Lavergne et al.13 developed a theory

for electrostatic acoustical transducers used in environments

and/or frequency ranges which are significantly different

from those for which they have been designed according to

the previous described work. By using a lubrication-type

approximation they obtained a Helmholtz-type equation for

the pressure in the gap and used a similar equation for the

pressure in the backchamber. Both equations contain delta

functions as forcing terms, meant to describe the effect of

the holes in the backplate and slit around the backplate.

In this paper, we propose a new approach based on a nu-

merical solution of the Navier-Stokes system for the air do-

main Dair composed of the gap, the holes and slits in the

backplate, the slit around the electrode and the backchamber.

Thus, the nonlocal coupling of the pressure in the gap with

the backchamber pressure through the holes in the backplate

is taken into consideration in a natural way without any need

to use the function defined by Petritskaya in Ref. 6.

The geometry used more often for building microphones is

that of an axi-symmetrical backplate with regular azimuthally

distributed circular holes. However, we can mention several

cases approaching more general geometries. Thus, Skvor in
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Refs. 14 and 15 reported a theoretical and experimental study

of a microphone having a nonplanar backplate. Also, Ref. 16

gives a simplified model of a microphone with square mem-

brane and a nonplanar backplate.

The method presented in this work can be applied to

general geometries of the backplate, holes, slits and back-

chamber. In the examples in this paper we consider firstly

the case of a 1/2-inch B&K microphone with an axi-

symmetrical backplate having regular azimuthally distrib-

uted circular holes. Another example, a MEMS microphone,

involves an octagonal backplate and square holes having still

a sectorial periodicity. In the general case, the numerical

procedure has to be applied to the whole diaphragm and not

to only to a slice of it. The only difference is that the number

of degrees of freedom will be much larger.

II. THE MEMBRANE EQUATION. THE ZERO ORDER
SOLUTION

A. The membrane equation

Consider the cylindrical system of coordinates (r, h, z) hav-

ing its origin at the center O of the rigid circular frame bounding

the membrane, and Oz-axis perpendicular to the equilibrium

position of the membrane and directed outwardly. The radius of

the frame is denoted by a and the origin of the azimuthal coordi-

nate h is set at the center of a hole in the backplate.

In the case of harmonic time variation eixt of the incom-

ing wave, the motion of the diaphragm is described by the

membrane equation which in cylindrical coordinates can be

written as

r2gðr; hÞ þ k2gðr; hÞ ¼ � pi

T
þ pðr; h; 0Þ

T
; 0 < r < a

(1)

Here, g (r, h) is the vertical membrane displacement and pi

the incident sound pressure assumed uniform (constant) over

the membrane surface. Also, p (r, h, 0) denotes the reaction

pressure at the membrane surface, and k is the wave number

of sound in the membrane,

k ¼ x
c
; c ¼

ffiffiffiffiffiffi
T

rM

r
(2)

where rM is the membrane mass surface density, T the mem-

brane tension and c denotes the sound speed in the mem-

brane. The reaction pressure p(r, h, 0), loading the

diaphragm, is the pressure due to the underlying air layer

squeezed between the membrane and backplate. Equation

(1) has to be completed by the boundary condition

gða; hÞ ¼ 0 (3)

stating that the membrane is supported by the rigid circular

frame at its periphery.

B. The zero order solution for the membrane
displacement

The zero order solution for the diaphragm motion is

obtained by neglecting in Eq. (1) the reaction pressure. The so-

lution of the problem of a circular membrane driven by the con-

stant pressure pi due to the sound field can be found in the book

by Blackstock17 (see p. 403). In our case it can be written as

gð0Þ ¼ pi

k2T

J0ðkrÞ
J0ðkaÞ � 1

� �
(4)

The very same solution enters also as the first term in the so-

lution given by Zuckerwar8 in Eq. (17) and by Lavergne

et al.13 in Eq. (11a). We note that this solution is not influ-

enced at all by the presence of the backplate and, conse-

quently, does not depend on the azimuthal coordinate h.

III. THE NAVIER-STOKES SYSTEM FOR THE AIR
DOMAIN Dair THE FIRST ORDER APPROXIMATION
OF THE REACTION PRESSURE

A. The linearized compressible Navier-Stokes system

The motion of the air in the domain underneath the mem-

braneDair composed of gap, holes and slits set in the backplate,

peripheral slit surrounding it and backchamber is described by

the Stokes approximation of the N-S compressible system writ-

ten in the case of time harmonic dependence as

ixq0v ¼ �rpþ l r2vþ 1

3
rr � v

� �
(5)

q0r � v ¼ �ixq (6)

and the equation of state

p ¼ qc2
T (7)

Here, v is the air particle velocity, q0 is the static air density,

q is the time-varying air density, and cT is the isothermal

speed of sound in air. According to Crandall3 the use of the

isothermal sound speed cT is appropriate for the gap region.

The boundary conditions associated with the system,

Eqs. (5)–(7), are

trðr; h; 0Þ ¼ thðr; h; 0Þ ¼ 0; tzðr; h; 0Þ ¼ ixgðr; hÞ (8)

along the membrane. Beside these, the velocity is zero,

v S ¼ 0j (9)

on the all immobile solid surface boundaries S of the fluid

domain (no slip condition).

The equations describing the motion of the diaphragm,

Eq. (1), and fluid flow, Eqs. (5)–(7), are coupled. Thus, the

fluid motion enters in the membrane equation by the reaction

pressure p(r, h, 0) while the diaphragm displacement influen-

ces the fluid flow by means of the boundary condition,

Eq. (8). To solve the problem we consider some iterations.

B. The first order approximation for the reaction
pressure. Computational methodology

For obtaining the first approximation for the reaction

pressure we use in the third boundary condition, Eq. (8), the
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zeroth order approximation for the diaphragm displacement

g0 given by formula, Eq. (4). Thus, we write this boundary

condition as

t0
z ðr; h; 0Þ ¼

ix
k2T

pi
J0ðkrÞ
J0ðkaÞ � 1

� �
(10)

We consider the case where the stationary backplate,

containing the holes, can be divided into a number of N0

identical circular sectors which can be obtained by rotation

of the basic sector by an angle equal to a multiple of 2p=N0:
As the forcing sound pressure is assumed constant over the

diaphragm, the boundary conditions for each circular sector

are the same. Consequently, the pressure will be a periodic

function with respect to the azimuthal angle h of period

2p=N0. Thus, the microphones B&K 4134 (1/2 in.) (top view

in Fig. l) and B&K 4146 (1 in.) studied by Zuckerwar in

Refs. 8, 9, and 13 and the microphone type WS2 presented

in Ref. 11 have N0¼ 6 while the B&K MEMS (1/4 in.) mea-

surement microphone described in the paper by Scheeper

et al.12 has N0¼ 4. Similar cases were considered by Petrit-

skaya6 and Tan and Miao10 Therefore, it is sufficient to

determine the pressure in a basic sector. The modeled do-

main can be further reduced by accounting for the symmetry

of the basic sector.

Finally, we need to build a finite element method (FEM)

model only for the air domain D0
air lying under the upper half

of the basic domain of diaphragm D0¼ {(r, h, 0)|0< r< a;

0< h�p/N0;}. Inside the domain D0
air , Eqs. (5)–(7) prove

true while on the surface @D0
air the boundary conditions will

be: symmetry conditions on the planes underneath the straight

line segments on the boundary of the domain D0, zero veloc-

ity on any part of solid boundaries of holes, slits and back-

chamber and tr(r, h, 0)¼ th (r, h, 0)¼ 0 and tz(r, h, 0) equal

to the value given by relationship, Eq. (10), on the boundary

of the air domain corresponding to the membrane.

In this section, we will develop a numerical model based

on the finite element method (FEM) for determining the

reaction pressure on the diaphragm. The frequency domain

linearized N-S, Eqs. (5)–(7) were implemented in the com-

mercial finite element method code, COMSOL Multiphysics

v.3.5. Thus, we used in the MEMS module in the program

Non-isothermal Stokes Flow. The steady-state analysis corre-

sponds to the system, Eqs. (5), (6), and (7), where x ¼ 0: In

order to take into consideration the term, ixq0v in Eq. (5)

and the term ixq in Eq. (6), we introduce the corresponding

terms in the weak form of the Stoke’s system of equations

implemented in COMSOL. A mesh of unstructured tetrahe-

dral elements using Lagrange�P2P1 interpolation polyno-

mials with a regular refinement at the gap was used. The

resulting system of equations was solved with the parallel

direct linear solver PARDISO. All the numerical work has

been performed on a workstation having 96 Gbyte RAM and

24 cores. The typical time consumption for one frequency

and a system of 123 295 degree of freedom (DOF) was

around 50 s.

The frequency limitation of this approach is given by

the condition that the number of DOF to be larger than

NDOF ¼ 1728�model volume measured in wavelength

cubed. This condition is a strengthening of the requirement

to have at least two DOF (practically 10–12) per wavelength

in the direction of propagation (see Ref. 19). In our case the

solution obtained is valid up to 250 kHz.

As a result of computation we obtain pcalc and hence the

reaction pressure on the membrane basic domain D0 can be

written as

pð1Þ ¼ pip
calc:

IV. THE FIRST ORDER SOLULTION FOR THE
DIAPHRAGM DISPLACEMENT

Once the first order approximation p(1) (r, h) of the reac-

tion pressure of the diaphragm is determined, the first order

displacement results by solving the equation

r2gð1Þðr; hÞ þ k2gð1Þðr; hÞ ¼ � pi

T
þ pi

T
pcalcðr; h; 0Þ (11)

with the perimeter condition

gð1Þða; hÞ ¼ 0: (12)

In this section, we present two methods for obtaining the dia-

phragm displacement: an analytical solution based on the

work of Rayleigh1 and a numerical solution using the FEM

method.

FIG. l. (Color online) (a) Top view of the B&K 4134 microphone after

removing the diaphragm. D0 is the basic domain and D0 its symmetrical do-

main. (b) The air domain D0
aircorresponding to the diaphragm domain D0.
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A. The analytical solution

As an analytical solution to this problem we will apply

the method given by Morse and Ingard18 (Section 9.3; pp.

543–544). Thus, in the case of a circular membrane, the

even part, with respect to h, of the diaphragm displacement

can be written as

gð1Þðr; hÞ ¼ pi

k2T

J0ðkrÞ
J0ðkaÞ � 1

� �
þ pi

pa2T

�
X
m;n

2� dm;0

k2 � k2
mn

� � gmnðr; hÞ
½J 0mðamnÞ�2

�
ð2p

0

ða

0

pcalcðr0; h0Þgm;nðr0; h0Þr0dr0dh0; (13)

where

gm;nðr; hÞ ¼ Jm
amn

a
r

	 

cos ðmhÞ; (14)

and the constants kmn are given by relationships

JmðamnÞ ¼ 0; kmn ¼ amn=a (15)

by means of the zeros of the Bessel function Jm(r).

The average displacement of the membrane enters into

several parameters. To determine it, we write

gð1Þðr;hÞ
D E

� 1

pa2

ð2p

0

ða

0

gð1Þðr;hÞrdrdh

¼ pi

k2T

J2ðakÞ
J0ðakÞþ

2pi

pa2T

X1
n¼0

1

a0nJ1ða0nÞk2� k2
0n

�
ða

0

ð2p

0

pcalcðr;hÞJ0ðk0nrÞrdrdh (16)

Remark 1. Equation (16) was proven for the case of dia-

phragms having a symmetry axis (Ox). As the integral of

“sine” terms cancels out it is also valid in the case of micro-

phones having circular diaphragms and arbitrarily shaped

backplates.

In the case of diaphragms having a symmetrical pattern

with N0 circular sectors the integral can be written asð2p

0

ða

0

pcalcðr; hÞJ0ðk0nrÞrdrdh

¼ 2N0

ð
D0

ð
pcalcðr; hÞJ0ðk0nrÞrdrdh (17)

B. A numerical solution

Once the reaction pressure on the membrane is known,

the first order displacement of the diaphragm g1 (r, h) can also

be obtained by numerical integration of the Helmholtz Eq.

(11). This can be performed by using the Multiphysics module

of the COMSOL finite element package by coupling it with

the program developed for determining the pressure on the di-

aphragm. For this we considered a nonstructured mesh of the

2D domain D0 containing a total of 12 480 triangles and have

used a Lagrange-quadratic interpolation. The resulting system

was solved again by using the PARDISO direct solver. Being a

2D problem the time required for this calculation is signifi-

cantly smaller than that necessary for determining the reaction

pressure. After determination of the first order displacement

its average value over the diaphragm is

g1ðr; hÞ
� �

¼ pi
2N0

pa2

ð ð
D0

g1ðr; hÞdS � pi

pa2
JðxÞ; (18)

where by J(x) has been denoted the integral of the first order

displacement over the membrane surface:

JðxÞ ¼ 2N0

ð ð
D0

gð1Þðr; h;xÞdS: (19)

V. ACOUSTICAL LUMPED ELEMENTS

A microphone can be viewed as a complex acoustical

electromechanical system having tightly coupled acoustical,

electrical and mechanical elements. A very much used mod-

eling method for determining the performance of a micro-

phone is the lumped-element approach in which simple

analytical (or numerically determined) expressions for mass,

compliance and damping have their equivalent correspond-

ing electrical counterparts in inductance, capacitance and re-

sistance, respectively. A standard representation for a

capacitive sensor including the radiation impedance, the me-

chanical damping, stiffness and mass, and electrical charac-

teristics as capacitance (including the parasitic one) and

electrical resistance can be found in the book by Kinsler

et al.20 A simplified acoustical lumped-element equivalent

circuit of the microphone is shown in Fig. 2. It includes the

membrane mass MM and compliance CM and also the resist-

ance RA and the compliance CA of the air in gap, holes and

backchamber.

Finally, the mechanical performance of a condenser

microphone consists of two parts: the mechanical sensitivity

and the thermal noise.

1. Mechanical sensitivity

The membrane parameters can be written directly as

FIG. 2. The simplified acoustical lumped-element equivalent circuit of the

microphone.
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MM ¼
4rM

3pa2
the diaphragm mass; (20)

and

CM ¼
ðpa2Þ2

8pT
the diaphragm compliance: (21)

At frequencies that are below the first resonant frequency of

the diaphragm the equation of the equivalent circuit of the

microphone can be written as

ðixÞ2MM þ ixRA þ
1

CA
þ 1

CM

� �
¼ 1

pa2MmðxÞ
: (22)

The source term in the right hand side of Eq. (22) contains

the mechanical sensitvity defined as

MmðxÞ ¼
gð1Þðr; hÞ
� �

pi
� JðxÞ

pa2
: (23)

Once mechanical sensitivity known, the real part of

Eq. (22) determine the air compliance as

CAðxÞ ¼ real
1

JðxÞ

� �
þ 4rMx2

3pa2
� 8pT

ðpa2Þ2

" #�1

: (24)

Further on, the imaginary part of Eq. (22) yields the air

resistance

RAðxÞ ¼
1

x
imag

1

JðxÞ

� �
: (25)

Finally, the quality factor Q is given by formula

Q ¼ 1

RA

ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
MM

1

CM
þ 1

CA

� �
:

s
(26)

A. Mechanical-thermal noise

The random movement of the molecules in a gas at a cer-

tain temperature and surrounding a mechanical structure leads

to random fluctuations in the energy transfer between struc-

ture and damping gas, which is generally referred to as

mechanical-thermal noise. According to Gabrielson,21 any

mechanical system in thermal equilibrium can be analyzed for

mechanical-thermal noise by adding a force generator along-

side each damper. Because a thermal equilibrium between the

mechanical device and the surroundings is assumed, the

energy lost towards the environment through the dissipative

friction (damping coefficient) must equal on average the

energy gained through the noise force. In the case of a micro-

phone the Nyquist theorem21 relates the spectral density of

the fluctuating force to the air resistance RA

Ff ¼
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
4kbToRA

p
½N=

ffiffiffiffiffiffi
Hz
p
�; (27)

Or the pressure spectral density of the mechanical-thermal
noise to the acoustic resistance Racs¼RA/S2 (where S is the

area of the active force):

Pf ¼
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
4kbToRacs

p
½N=

ffiffiffiffiffiffi
Hz
p
�; (28)

where kb is the Boltzmann constant (1.38� 10–23 J/K) and

To is the absolute temperature (K). The background noise

mean square pressure (A-weighted) of the mechanical noise

can be computed as

N2
f ¼

ðf2

f1

4kbToRAA2ðf Þdf ; (29)

where Aðf Þdenotes the function of the A-weighted filter, and

f1¼ 10 Hz, f2¼ 20 kHz.

VI. CALCULATION OF MECHANICAL PERFORMANCE
OF SOME MICROPHONES

In this section, we shall compute the mechanical per-

formance of the B&K 4134 and also of a new design for a

MEMS microphone.

A. The B&K 4134 (1/2 in.) microphone

The arrangement of acoustical slit and holes in the back-

plate of the B&K microphone type 4134 is shown in Fig.

l(a). Figure l(b) shows the corresponding air domain D0
air

used for determining the reaction pressure. The mechanical

parameters of the membrane, the values of geometrical pa-

rameters of the microphone and the thermo-acoustical pa-

rameters of the air are those given by Zuckerwar.8 The

membrane has a radius a ¼ 4.45[mm], the thickness 5[lm]

the surface density rm ¼ 0.0445[kg/m�2] and the tension

T¼ 3162[N/m]. Also, the radius of the circular backplate is

3.61[mm], the radius of the six holes equals 0.51[mm], the

distance of the centers of the holes to the membrane center

equals 2.03[mm]. The length (depth) of a hole is 0.84[mm]

while the length of the peripheral slit is 0.3[mm]. Finally,

the gap (the distance between average position of membrane

and backplate) equals 20.77[lm] and the backchamber vol-

ume is 1.264� 10�7[m3]. In all the calculations the density

of the air is considered to be q0 ¼ 1.2[kg/m3] its viscosity

l¼1.89� 10�5[kg/m/s�3] and the isothermal sound of speed

in air cT¼ 290[m/s].

Figure 3 compares the sensitivity obtained by using the

reaction pressure obtained numerically and the two methods

for solving the membrane equation: analytical method given

in Section A (continuous line) and the numerical method of

Section B (line with circles) with the measured values taken

from Ref. 8 and shown in the two figures as empty circles.

Figure 3(a) shows the variation of amplitude sensitivity with

frequency of the incoming wave and Fig. 3(b) plots the vari-

ation of phase response with the same frequency. In both

cases the analytical and numerically obtained results are

very close. We note also that the Mechanical Sensitivity

determined numerically is overdamped as compared with the

measured values.
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Finally, by using the given formulas, we provide evalua-

tion of the thermal noise. Thus, Eq. (25) yields the value Racs

¼ 1.2� 108 [Ns/m5] for the mechanical resistance and hence

the value 1:39� 10�6½P=
ffiffiffiffiffiffi
Hz
p
� for the pressure spectral den-

sity of the mechanical-thermal noise. This gives a mechani-

cal thermal noise of 17.9[dB (A)]. This compares well with

the values 19.7[dB (A)] corresponding to Zuckerwar’s pa-

per,8 18.9[dB (A)] given by Tarnow in Ref. 22, 18.3[dB (A)]

found by Tan and Miao in Ref. 23, and the value 18.0[dB

(A)] given in Ref. 24.

B. A new design of a MEMS microphone

The 1/4-inch, MEMS measurement microphone, of con-

denser type, developed by B&K12 in 2003, has a very low

level of mechanical-thermal noise comparable to the noise

level corresponding to a 1/2-inch microphone discussed in

the previous subsection. This low level of mechanical-

thermal noise is ensured by a 20 [lm] gap between the

diaphragm and the square backplate (which measures 2.8

� 2.8[mm2]) the slit arround the backplate and the four

acoustic square holes perforated in the backplate. Also, the

high sensitivity of the microphone is achieved by using a

quite large diaphragm for a MEMS microphone of

� ¼ 3:9 mm½ �: (The diaphragm radius is also limited by the

design constraint of a 1/4-inch microphone housing). The

micromachined diaphragm has the thickness 0.5[lm], the

mass surface density rm¼ 0.0015 [kg/m2] and tension

T¼ 170[N/m]. Each square hole has the side length 80[lm],

the distance of the centers of the holes to the membrane cen-

ter equals 0.55[mm], and the depth (the backplate thickness)

equals to 150[lm]. The microphone silicon chip contains

the diaphragm and backplate and it is mounted onto a ring

of silicone glue. For packaging and testing purposes, the

FIG. 3. (Color online) (a) Amplitude (dB) of the mechanical sensitivity of the B&K 4134 microphone, as a function of frequency, calculated analytically (con-

tinuous line) and numerically (line and circles) and the measured values (scattered empty circles). (b) The phase of the mechanical sensitivity of the micro-

phone B&K 4134, as a function of frequency, calculated analytically (continuous line) and numerically (line and circles) and measured values (scattered

empty circles).

FIG. 4. (Color online) (a) Top view of the proposed MEMS design after

removing the diaphragm. D0 is the basic domain and D0 its symmetrical do-

main. (b) The air domain D0
air corresponding to the diaphragm domain D0

for proposed MEMS design.

FIG. 5. (Color online) Amplitude (dB) of the mechanical sensitivity of the

proposed microphone, as a function of frequency, calculated numerically

(continuous line) and the measured values (scattered empty circles).
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microphone is housed in a 1/4-inch microphone titanium

body. This gives a backchamber volume of 76[mm3] which

corresponds to a height of 6.4 [mm].

For determining the mechanical performance of the

microphone, by using the method developed by Zuckerwar,

Miao et al.,10 considered a model with a circular backplate

and round holes. The analysis in paper10 shows also that by

modifying the gap to 10[lm] it is possible to build with the

same technique new MEMS microphones for nonmeasure-

ment applications.

In this section, we investigate the mechanical properties

of a microphone completely micromachined, the silicon chip

including also the backchamber. The diaphragm has the ra-

dius a ¼ 1.95[mm], the octagonal backplate (see Fig. l in

Ref. 12 and Fig. l(b) in Ref. 10) has the large sides length

equal to 2.2[mm] and the distance between two opposite

large sides of 2.8[mm] [Fig. 4(a)]. It contains four square

acoustical holes which measure 80� 80[lm2]. The deep of

the backchamber equals 0.8[mm]. Due to periodicity and

symmetry the bounary-value problems have to be solved for

the domain D0 in Fig. 4(a) (for the diaphragm displacement)

and the 3D domain shown in Fig. 4(b) for the pressure under

the diaphragm. For both boundary value problems numerical

methods have been applied.

The normalized sensitivity obtained by using the ana-

lyzed MEMS condenser microphone is plotted in Fig. 5, ver-

sus frequency of the incoming wave, as a continuous line.

In the same figure the scattered empty circles correspond to

the measured response of the MEMS measurement micro-

phone given in Fig. 9 in Ref. 12. The good agreement of the

FIG. 6. (Color online) (a) Measured displacement field of the membrane of B&K 4134 microphone at 40 kHz reproduced from the paper by Lavergne et al.13.

(b) The calculated displacement field of the membrane of B&K 4134 microphone at 40 kHz.

FIG. 7. (Color online) (a) Measured displacement field of the membrane of B&K 4134 microphone at 70 kHz reproduced from the paper by Lavergne et al.13

(b) The calculated displacement field of the membrane of B&K 4134 microphone at 70 kHz.

3704 J. Acoust. Soc. Am., Vol. 130, No. 6, December 2011 D. Homentcovschi and R. N. Miles: Mechanical response of a condenser microphone

Downloaded 16 Dec 2011 to 128.226.77.128. Redistribution subject to ASA license or copyright; see http://asadl.org/journals/doc/ASALIB-home/info/terms.jsp



calculated and measured data shows that the influence of the

very deep backchamber in the MEMS measurement micro-

phone it is not so important. Presumably, the shorter back-

chamber is responsible for the slight overdamping of the

proposed MEMS microphone.

Now, by using the given formulas, Eqs. (25), (28), and

(29), we can give evaluation of the thermal noise. Thus, we

obtain Racs ¼ 2.97 � 108[Ns/m5] for the mechanical resistance.

This gives a mechanical thermal noise of 21.8[dB(A)] which

compares well with the values 20:8� 21:7½dBðAÞ� given in

Table IV in Ref. 12 for the Thermal noise for B&K MEMS

measurement microphones.

C. The displacement of membrane

The paper by Lavergne et al.13 contains the displacement

field of the B&K 1/2 in. microphone obtained experimentally

using a scanning laser vibrometer. Figure 6(a) shows the dis-

placement field of the membrane of the B&K 4134 microphone

at 40 kHz, and the same field measured at 70 kHz is shown in

Fig. 7(a). Both figures are taken from the cited paper. The dis-

placement field of the membrane of the same microphone and

for the same frequencies resulted by using the numerically

obtained reaction pressure coupled with the numerical integra-

tion of the membrane equation are shown in Fig. 6(b) (for

40 kHz) and Fig. 7(b) for 70 kHz. In both cases the calculated

values look very similar to the measured displacements.

VII. CONCLUSIONS

The main result of this work is the determination of the

reaction pressure on the diaphragm due the air domain Dair

underneath it by using a numerical approach based on the fi-

nite element method. Afterwards, the membrane displace-

ment can be obtained analytically or numerically. In both

cases the results are in very close agreement. The method is

applied to determine the sensitivity and the mechano-

thermal noise of the classical B&K 4134 1/2-inch micro-

phone. Also, in the last section the displacement field of the

membrane of the B&K 4134 microphone is determined for

the frequencies 40 kHz and 70 kHz. The results compare

favorably with the measured values published in the litera-

ture. The paper also proposes a new design, completly

micromachined, (the chip including also the back-volume)

of the B&Kl/4-inch MEMS measurement microphone. De-

spite the fact that this new design has a backvolume only 0.8

[mm] deep as compared with 6.4[mm] of the B&K micro-

phone its mechanical response fits very well the measured

values published in the literature.
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ABSTRACT: Vibrating membranes are the cornerstone of acoustic technology, forming the 

backbone of modern loudspeakers and microphones. Acoustic performance of condenser 

microphone is derived mainly from the membrane’s size and achievable static tension. The widely 

studied and available nickel has been the one of dominant membrane material for several decades. 

In this paper we introduce multilayer graphene as membrane material for a condenser microphone. 

The graphene device outperforms a high end commercial nickel-based microphone over a 

significant part of the acoustic spectrum, with a larger than 10 dB enhancement of sensitivity. Our 
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experimental results are supported with numerical simulations, which show that a 300 layer thick 

graphene membrane under maximum tension would offer excellent extension of the frequency 

range, up to 1 MHz, with similar sensitivity as commercial condenser microphones. 

1. Introduction 

Graphene has emerged as an exciting new material for fundamental research and novel 

applications, due to its many remarkable properties such as ultrahigh carrier mobility [1], high 

optical transparency [2,3], and enormous chemical reactivity [4]. Furthermore, graphene shows 

record high thermal conductivity [5] and Young’s modulus [6], making it an excellent thin 

membrane. Measurements have shown that monolayer graphene has a breaking strength of 

42 N/m which is over 200 times greater than a hypothetical steel film of the same thickness, with 

a tensile modulus of 1 TPa [6]. Graphene membranes are lightweight, and their mechanical, 

thermal and electrical properties promise remarkable possibilities in acoustic applications. 

Although electrical and optical properties of graphene have been extensively studied and applied, 

the first utilizations of the mechanical properties of graphene in acoustics have only recently 

been realized, with the first demonstrations of a graphene thermoacoustic device [7-9], 

electrostatic loudspeaker [10] and a graphene earphone [11,12].  

Vibrating lightweight membranes are of tremendous relevance in the acoustic industry, as 

exemplified by the reign of condenser microphones as the best platform for recording and 

measuring acoustic waves using the same pressure detection principle as the human ear, with 

high quality, repeatable and predictable performance [13]. Condenser microphones, discovered 

at Bell Labs in 1916, utilize a vibrating membrane as one plate of a capacitor charged by a 

polarization voltage. Incident acoustic waves set the membrane in motion, which is detected with 
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an attached electronic circuit. Most improvements to condenser microphones in the last three 

decades focused on the electronics, for example on improving the analogue to digital converters 

and placing them inside the microphone body to minimize interference and noise in analogue 

signal transmission chain. An exception is the rise of microphones based on 

microelectromechanical systems (MEMS), typically using thin silicon as the membrane material 

[14]. MEMS-based microphones offer the advantage of small size, which is important for 

applications in hearing aids and aeroacoustic arrays [15]. MEMS microphones feature 

membranes with a thickness on the order of 1 /mu m and have shown a frequency response 

similar to conventional macroscopic microphones [16]. The nanoscale thickness of graphene 

membranes and their exceptional mechanical properties make them an excellent candidate for 

even smaller microphones with enhanced spectral response.  

Here we report an experimental realization of a standard condenser microphone with a multilayer 

graphene membrane with performance comparable to a professional microphone, at a membrane 

thickness of only 25 nm. Packaged in the same commercial casing and using the same electronic 

amplifier, the graphene microphone sensitivity outperforms a professional microphone (Brüel & 

Kjaer (B&K) 4134 microphone) by 12 dB, at frequencies up to 12 kHz. The experimental data 

are supported with numerical simulations, which additionally show that a membrane consisting 

of 300 layers of graphene would respond in a usable frequency range extending up to 1 MHz, in 

the ultrasonic part of the spectrum. 

2. Fabrication 

Our sample consists of multilayer graphene grown on nickel foil with chemical vapour 

deposition (Graphene Platform). The nickel is etched away in a 40 mg/ml iron chloride water 
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solution, yielding a floating multilayer graphene film (Figure 1a). The graphene film is scooped 

out of the solution onto a supporting polyethylene terephthalate (PET) frame which has a circular 

hole in the center (Figure 1b). The graphene covers the hole to form the membrane. The diameter 

of the hole and membrane was varied between 5 mm and 12 mm with similar results. The 

membrane is subsequently left to dry for 24 hours prior to mounting the device into the 

microphone casing. This fabrication procedure results in a high yield of membranes, at a success 

rate larger than 70%. To increase the yield, the membranes were not rinsed in water or other 

solvents [6]. As a result, a residue of iron chloride is left on the membrane, as confirmed with 

scanning electron microscopy (see Supplementary Information). The residue does not appear to 

significantly affect the performance of the microphone, as demonstrated in the following 

paragraphs. Raman spectroscopy was used to confirm that the membrane consists of graphene 

(Supplement). Atomic force microscopy of sacrificial membranes indicated an average thickness 

of 25 nm (Supplement). 



 5 

Figure 1. Preparation of the graphene membrane. Multilayer graphene on nickel is placed in an 

etching solution (a). The floating graphene layer is scooped onto a support with a predefined hole 

for the membrane (b). The membrane is loaded onto a holder which is then fixed into the 

professional microphone cartridge (d). A photograph of the graphene membrane in the microphone 

holder (d). The dashed line encircles the freestanding part of the membrane. 

3. Measurements 

Microphone performance is measured by recording a constant amplitude sine sweep from 10 Hz 

to 24 kHz, played on a small loudspeaker. The signal was amplified with a professional 

microphone preamplifier (B&K ZC0032) and analyzed with a PrismSound dScope Series III 



 6 

signal generator and analyzer. The comparison (results in Figure 2.) and substitution (result in 

Figure 4.) methods were used to test several graphene microphone against the professional 

microphone (details are given in the Supplementary Information). During the measurements a 

DC polarization voltage of 200 V was applied to the microphones. Frequency response of small 

loudspeaker at 90° incidence with professional and graphene microphone is presented in Figure 

2. 

 

Figure 2. Frequency response of the small loudspeaker measured with a 5 mm membrane diameter 

graphene microphone (red curve) and a chosen professional microphone (black dashed curve), 

using the comparison method at 90° incidence angle. Sensitivity is higher than the professional 

microphone at all frequencies below 11 kHz.  

The distance between the membrane and the oppositely charged condenser back plate was 

crudely controlled by tightening and loosening the holder screw (see Supplementary 

Information). The microphone sensitivity increases as the membrane approaches the back plate, 

down to a minimal distance of 18.6 μm allowed by the microphone casing. The membrane static 

tension is estimated using the membrane collapse effect [18,19] as: 

𝑇𝑚0 = 𝜎𝑡 =
27𝜀0𝑟2𝑉𝑝

2

64ℎ3  [
𝑁

𝑚
], 
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where σ is membrane tensile stress (N/m2), t is membrane thickness (m), ε0 is dielectric 

permittivity of air (= 8.85x10-12 F/m), r is radius of membrane (m), Vp is polarization voltage (V) 

and h is nominal distance from diaphragm to back plate (m). 

For a polarization voltage of 200 V and a membrane radius of 5 mm, the estimated static tension 

is approximately 640 N/m. 

The static tension on the graphene membrane is five times smaller than the manufacturer 

specified tension on the nickel membrane of the professional microphone. A small static tension 

results in a large microphone efficiency, as in [20]: 

𝑀 =  
𝑉𝑝𝑟2

8ℎ𝑇𝑚0
 [

V

Pa
] , 

and is hence the most likely reason for the superior performance of the graphene microphone. 

The tradeoff of small membrane tension is a low cutoff frequency, given as [21]: 

𝑓𝑚𝑎𝑥 =
2.4

2𝜋𝑟
√

𝑇𝑚0

𝜎𝑚
 , 

where σm  is surface mass density of membrane (kg/m2). 

However, the graphene membrane has a surface mass density three orders of magnitude smaller 

than that of the nickel membrane of the professional microphone, which compensates for the 

weak tension. 

4. FEM simulation and measurements 

To reinforce the experimental results and explore the limits of graphene microphone membranes, 

we employ finite element method (FEM) calculations. We start from the well-known publicly 

available professional condenser microphone model in Comsol Multiphysics. 
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Figure 3. Model used in FEM simulations. a) 2D condenser microphone simplified model b) 

Section of the symmetric professional condenser microphone system c) Full 3D model with 

membrane static deflection (in colour) under applied polarization voltage. 

Two different models were employed, a simplified 2D axial model of the condenser microphone 

(Figure 4.a) and a detailed 3D symmetric model of the professional condenser microphone 

(Figure 4.b and c). Both models are multiphysics problems that involve several physics 

interfaces: Thermoacoustics, Electrostatics, Moving Mesh, and a Membrane model. Each finite-

element model is solved fully coupled using the frequency-domain linear perturbation solver. 

This includes the DC charging (pre-polarization) and deformation of the membrane - “pull-in” 

voltage, which makes out the zeroth order linearization point. Many microphones contain an air-

filled back volume below the electrode. In our analysis we disregard the effect of the back 

pressure of air in this volume. The membrane is deformed due to electrostatic forces from 
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charging the capacitor and the pressure variation due to the incoming uniform acoustic signal 

pin. The dimensions and parameters of the simulation are given in Table S1 (Supplementary 

Information). The membrane material is nickel, 5 µm tick, with applied static tension of 

3160 N/m. 

Simulations were performed for the three cases: the original professional microphone; the same 

microphone but with a 30-layer graphene membrane replacing the original nickel membrane, as 

was the case in experiment; and a ¼” microphone with a hypothetical 300-layer graphene 

membrane (see Supplementary Information). The simulated response spectrum of the 30-layer 

graphene microphone membrane, compared to the measured microphone response, is depicted in 

Figure 4. The normalized results, in agreement with the measurements, indicate that the graphene 

microphone has sensitivity higher than the professional condenser microphone by more than 

11 dB, up to a frequency of 11 kHz. At higher frequencies, the larger static tension of the 

professional microphones nickel membrane starts to dominate, leading to a reduced relative 

performance of the graphene microphone. The frequency response and sensitivity in the limit of 

thin membranes are defined by the geometry and membrane static tension, and air load on the 

membrane dominates the mass of the membrane. In this limit, it is interesting to consider slightly 

thicker graphene membranes, which could theoretically support a larger static tension. The 

graphene microphone suffers reduced performance at frequencies larger than 2 kHz, due to the 

supporting metal ring. 
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Figure 4. Comparison of the measured graphene microphone response (30 layer graphene 

membrane, red curve) to the FEM calculated response (black dashed curve), all normalized to the 

average measurements of the original professional condenser microphone. Overall difference in 

response is an influence of the microphone membrane holder (metal ring: 25 mm outer diameter, 

10 mm inner diameter, 3 mm tick). 

The strength of a graphene membrane scales linearly with the number of layers [23]. In 

accordance with Eq. 3, membranes that support a larger static tension have larger cutoff 

frequencies. Figure 5. depicts simulated response of a 300 layer graphene membrane, under the 

same experimental conditions achieved in the rest of this work. The microphone exhibits superb 

performance over a wide frequency range, up to 1 MHz. The microphone sensitivity at 

frequencies below 1 MHz remains comparable to the professional small membrane professional 

condenser extended range microphones (B&K 4136 and B&K 4138). 
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Figure 5. FEM simulation of a 300 layer graphene microphone. 

5. Conclusions 

In conclusion, we demonstrate multilayer graphene microphones with a performance comparable 

to professional microphones. A microphone with a 30 layer graphene membrane displays up to 

15 dB higher sensitivity compared to a commercial microphone, at frequencies up to 11 kHz. 

Finite element simulations confirm graphene microphone sensitivity and cutoff, and indicate that 

a microphone with a 300 layer graphene membrane would show similar sensitivity as state of the 

art condenser microphones at frequencies up to 1 MHz, deeply entering the ultrasonic part of the 

spectrum. Our work paves the way for the use of widely available and inexpensive graphene in 

acoustics and touches upon the important ultrasound part of the spectrum, unreachable by the 

conventional state of the art microphones. 
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ABSTRACT: Vibrating membranes are the cornerstone of acoustic technology, forming the 

backbone of modern loudspeakers and microphones. Acoustic performance of condenser 

microphone is derived mainly from the membrane’s size and achievable static tension. The widely 

studied and available nickel has been the one of dominant membrane material for several decades. 

In this paper we introduce multilayer graphene as membrane material for a condenser microphone. 

The graphene device outperforms a high end commercial nickel-based microphone over a 

significant part of the acoustic spectrum, with a larger than 10 dB enhancement of sensitivity. Our 
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experimental results are supported with numerical simulations, which show that a 300 layer thick 

graphene membrane under maximum tension would offer excellent extension of the frequency 

range, up to 1 MHz, with similar sensitivity as commercial condenser microphones. 

1. Introduction 

Graphene has emerged as an exciting new material for fundamental research and novel 

applications, due to its many remarkable properties such as ultrahigh carrier mobility [1], high 

optical transparency [2,3], and enormous chemical reactivity [4]. Furthermore, graphene shows 

record high thermal conductivity [5] and Young’s modulus [6], making it an excellent thin 

membrane. Measurements have shown that monolayer graphene has a breaking strength of 

42 N/m which is over 200 times greater than a hypothetical steel film of the same thickness, with 

a tensile modulus of 1 TPa [6]. Graphene membranes are lightweight, and their mechanical, 

thermal and electrical properties promise remarkable possibilities in acoustic applications. 

Although electrical and optical properties of graphene have been extensively studied and applied, 

the first utilizations of the mechanical properties of graphene in acoustics have only recently 

been realized, with the first demonstrations of a graphene thermoacoustic device [7-9], 

electrostatic loudspeaker [10] and a graphene earphone [11,12].  

Vibrating lightweight membranes are of tremendous relevance in the acoustic industry, as 

exemplified by the reign of condenser microphones as the best platform for recording and 

measuring acoustic waves using the same pressure detection principle as the human ear, with 

high quality, repeatable and predictable performance [13]. Condenser microphones, discovered 

at Bell Labs in 1916, utilize a vibrating membrane as one plate of a capacitor charged by a 

polarization voltage. Incident acoustic waves set the membrane in motion, which is detected with 
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an attached electronic circuit. Most improvements to condenser microphones in the last three 

decades focused on the electronics, for example on improving the analogue to digital converters 

and placing them inside the microphone body to minimize interference and noise in analogue 

signal transmission chain. An exception is the rise of microphones based on 

microelectromechanical systems (MEMS), typically using thin silicon as the membrane material 

[14]. MEMS-based microphones offer the advantage of small size, which is important for 

applications in hearing aids and aeroacoustic arrays [15]. MEMS microphones feature 

membranes with a thickness on the order of 1 /mu m and have shown a frequency response 

similar to conventional macroscopic microphones [16]. The nanoscale thickness of graphene 

membranes and their exceptional mechanical properties make them an excellent candidate for 

even smaller microphones with enhanced spectral response.  

Here we report an experimental realization of a standard condenser microphone with a multilayer 

graphene membrane with performance comparable to a professional microphone, at a membrane 

thickness of only 25 nm. Packaged in the same commercial casing and using the same electronic 

amplifier, the graphene microphone sensitivity outperforms a professional microphone (Brüel & 

Kjaer (B&K) 4134 microphone) by 12 dB, at frequencies up to 12 kHz. The experimental data 

are supported with numerical simulations, which additionally show that a membrane consisting 

of 300 layers of graphene would respond in a usable frequency range extending up to 1 MHz, in 

the ultrasonic part of the spectrum. 

2. Fabrication 

Our sample consists of multilayer graphene grown on nickel foil with chemical vapour 

deposition (Graphene Platform). The nickel is etched away in a 40 mg/ml iron chloride water 
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solution, yielding a floating multilayer graphene film (Figure 1a). The graphene film is scooped 

out of the solution onto a supporting polyethylene terephthalate (PET) frame which has a circular 

hole in the center (Figure 1b). The graphene covers the hole to form the membrane. The diameter 

of the hole and membrane was varied between 5 mm and 12 mm with similar results. The 

membrane is subsequently left to dry for 24 hours prior to mounting the device into the 

microphone casing. This fabrication procedure results in a high yield of membranes, at a success 

rate larger than 70%. To increase the yield, the membranes were not rinsed in water or other 

solvents [6]. As a result, a residue of iron chloride is left on the membrane, as confirmed with 

scanning electron microscopy (see Supplementary Information). The residue does not appear to 

significantly affect the performance of the microphone, as demonstrated in the following 

paragraphs. Raman spectroscopy was used to confirm that the membrane consists of graphene 

(Supplement). Atomic force microscopy of sacrificial membranes indicated an average thickness 

of 25 nm (Supplement). 
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Figure 1. Preparation of the graphene membrane. Multilayer graphene on nickel is placed in an 

etching solution (a). The floating graphene layer is scooped onto a support with a predefined hole 

for the membrane (b). The membrane is loaded onto a holder which is then fixed into the 

professional microphone cartridge (d). A photograph of the graphene membrane in the microphone 

holder (d). The dashed line encircles the freestanding part of the membrane. 

3. Measurements 

Microphone performance is measured by recording a constant amplitude sine sweep from 10 Hz 

to 24 kHz, played on a small loudspeaker. The signal was amplified with a professional 

microphone preamplifier (B&K ZC0032) and analyzed with a PrismSound dScope Series III 
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signal generator and analyzer. The comparison (results in Figure 2.) and substitution (result in 

Figure 4.) methods were used to test several graphene microphone against the professional 

microphone (details are given in the Supplementary Information). During the measurements a 

DC polarization voltage of 200 V was applied to the microphones. Frequency response of small 

loudspeaker at 90° incidence with professional and graphene microphone is presented in Figure 

2. 

 

Figure 2. Frequency response of the small loudspeaker measured with a 5 mm membrane diameter 

graphene microphone (red curve) and a chosen professional microphone (black dashed curve), 

using the comparison method at 90° incidence angle. Sensitivity is higher than the professional 

microphone at all frequencies below 11 kHz.  

The distance between the membrane and the oppositely charged condenser back plate was 

crudely controlled by tightening and loosening the holder screw (see Supplementary 

Information). The microphone sensitivity increases as the membrane approaches the back plate, 

down to a minimal distance of 18.6 μm allowed by the microphone casing. The membrane static 

tension is estimated using the membrane collapse effect [18,19] as: 

𝑇𝑚0 = 𝜎𝑡 =
27𝜀0𝑟2𝑉𝑝

2

64ℎ3  [
𝑁

𝑚
], 
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where σ is membrane tensile stress (N/m2), t is membrane thickness (m), ε0 is dielectric 

permittivity of air (= 8.85x10-12 F/m), r is radius of membrane (m), Vp is polarization voltage (V) 

and h is nominal distance from diaphragm to back plate (m). 

For a polarization voltage of 200 V and a membrane radius of 5 mm, the estimated static tension 

is approximately 640 N/m. 

The static tension on the graphene membrane is five times smaller than the manufacturer 

specified tension on the nickel membrane of the professional microphone. A small static tension 

results in a large microphone efficiency, as in [20]: 

𝑀 =  
𝑉𝑝𝑟2

8ℎ𝑇𝑚0
 [

V

Pa
] , 

and is hence the most likely reason for the superior performance of the graphene microphone. 

The tradeoff of small membrane tension is a low cutoff frequency, given as [21]: 

𝑓𝑚𝑎𝑥 =
2.4

2𝜋𝑟
√

𝑇𝑚0

𝜎𝑚
 , 

where σm  is surface mass density of membrane (kg/m2). 

However, the graphene membrane has a surface mass density three orders of magnitude smaller 

than that of the nickel membrane of the professional microphone, which compensates for the 

weak tension. 

4. FEM simulation and measurements 

To reinforce the experimental results and explore the limits of graphene microphone membranes, 

we employ finite element method (FEM) calculations. We start from the well-known publicly 

available professional condenser microphone model in Comsol Multiphysics. 
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Figure 3. Model used in FEM simulations. a) 2D condenser microphone simplified model b) 

Section of the symmetric professional condenser microphone system c) Full 3D model with 

membrane static deflection (in colour) under applied polarization voltage. 

Two different models were employed, a simplified 2D axial model of the condenser microphone 

(Figure 4.a) and a detailed 3D symmetric model of the professional condenser microphone 

(Figure 4.b and c). Both models are multiphysics problems that involve several physics 

interfaces: Thermoacoustics, Electrostatics, Moving Mesh, and a Membrane model. Each finite-

element model is solved fully coupled using the frequency-domain linear perturbation solver. 

This includes the DC charging (pre-polarization) and deformation of the membrane - “pull-in” 

voltage, which makes out the zeroth order linearization point. Many microphones contain an air-

filled back volume below the electrode. In our analysis we disregard the effect of the back 

pressure of air in this volume. The membrane is deformed due to electrostatic forces from 
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charging the capacitor and the pressure variation due to the incoming uniform acoustic signal 

pin. The dimensions and parameters of the simulation are given in Table S1 (Supplementary 

Information). The membrane material is nickel, 5 µm tick, with applied static tension of 

3160 N/m. 

Simulations were performed for the three cases: the original professional microphone; the same 

microphone but with a 30-layer graphene membrane replacing the original nickel membrane, as 

was the case in experiment; and a ¼” microphone with a hypothetical 300-layer graphene 

membrane (see Supplementary Information). The simulated response spectrum of the 30-layer 

graphene microphone membrane, compared to the measured microphone response, is depicted in 

Figure 4. The normalized results, in agreement with the measurements, indicate that the graphene 

microphone has sensitivity higher than the professional condenser microphone by more than 

11 dB, up to a frequency of 11 kHz. At higher frequencies, the larger static tension of the 

professional microphones nickel membrane starts to dominate, leading to a reduced relative 

performance of the graphene microphone. The frequency response and sensitivity in the limit of 

thin membranes are defined by the geometry and membrane static tension, and air load on the 

membrane dominates the mass of the membrane. In this limit, it is interesting to consider slightly 

thicker graphene membranes, which could theoretically support a larger static tension. The 

graphene microphone suffers reduced performance at frequencies larger than 2 kHz, due to the 

supporting metal ring. 
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Figure 4. Comparison of the measured graphene microphone response (30 layer graphene 

membrane, red curve) to the FEM calculated response (black dashed curve), all normalized to the 

average measurements of the original professional condenser microphone. Overall difference in 

response is an influence of the microphone membrane holder (metal ring: 25 mm outer diameter, 

10 mm inner diameter, 3 mm tick). 

The strength of a graphene membrane scales linearly with the number of layers [23]. In 

accordance with Eq. 3, membranes that support a larger static tension have larger cutoff 

frequencies. Figure 5. depicts simulated response of a 300 layer graphene membrane, under the 

same experimental conditions achieved in the rest of this work. The microphone exhibits superb 

performance over a wide frequency range, up to 1 MHz. The microphone sensitivity at 

frequencies below 1 MHz remains comparable to the professional small membrane professional 

condenser extended range microphones (B&K 4136 and B&K 4138). 
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Figure 5. FEM simulation of a 300 layer graphene microphone. 

5. Conclusions 

In conclusion, we demonstrate multilayer graphene microphones with a performance comparable 

to professional microphones. A microphone with a 30 layer graphene membrane displays up to 

15 dB higher sensitivity compared to a commercial microphone, at frequencies up to 11 kHz. 

Finite element simulations confirm graphene microphone sensitivity and cutoff, and indicate that 

a microphone with a 300 layer graphene membrane would show similar sensitivity as state of the 

art condenser microphones at frequencies up to 1 MHz, deeply entering the ultrasonic part of the 

spectrum. Our work paves the way for the use of widely available and inexpensive graphene in 

acoustics and touches upon the important ultrasound part of the spectrum, unreachable by the 

conventional state of the art microphones. 
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